Chapter 11, Installing, Managing, and Troubleshooting Hardware Devices and Drivers

|1|
Chapter Overview


A.
Understanding Automatic and Manual Hardware Installation


B.
Configuring and Troubleshooting Hardware Devices


C.
Viewing and Configuring Hardware Profiles


D.
Configuring, Monitoring, and Troubleshooting Driver Signing


E.
Configuring Computers with Multiple Processors

Chapter 11, Lesson 1

Understanding Automatic and Manual Hardware Installation
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1.
Installing Hardware Automatically


A.
Microsoft Windows XP Professional detects, installs, and configures most Plug and Play hardware automatically.


1.
The appropriate driver must be available.


2.
The basic input/output system (BIOS) must be one of the following: 

a.
Plug and Play BIOS


b.
Advanced Configuration and Power Interface (ACPI) BIOS


B.
Windows XP Professional often identifies non–Plug and Play hardware and automatically installs and configures it.
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C.
Windows XP Professional displays the Found New Hardware Wizard when it detects a new piece of hardware that cannot be installed automatically.
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2.
Using the Add Hardware Wizard

A.
You can start the Add Hardware Wizard to initiate installation for undetected Plug and Play or non–Plug and Play hardware.


B.
Click Next to close the Welcome To The Add Hardware Wizard page.


C.
Windows XP Professional searches for new hardware devices.


1.
If Windows XP Professional detects any new Plug and Play devices, it installs them.


2.
If Windows XP Professional detects any other new devices that it cannot install, it starts the Found New Hardware Wizard.


3.
If Windows XP Professional detects no new devices, it displays the Is The Hardware Connected page.
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3.
Confirming Hardware Installation with Device Manager

A.
Windows XP Professional uses icons in the Device Manager window to identify each installed hardware device.


B.
The normal icon indicates the device is functioning normally.


C.
The stop sign on an icon indicates that Windows XP Professional disabled the device because of hardware conflicts.


1.
To correct this, you should manually set hardware resources.

a.
Right-click the device icon, and then click Properties.

b.
Assign resources available on the system.

D.
The exclamation point on an icon indicates one of the following:

1.
The device is incorrectly configured.


2.
The driver for the devices is missing.
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4.
Installing Hardware Manually


A.
Determine which hardware resources are required by looking in the product documentation.

B.
Understand the hardware resources.

1.
Interrupts


a.
Hardware devices use interrupts to send messages.


b.
The microprocessor knows these messages as interrupt requests (IRQs).

c. The microprocessor uses IRQs to determine 


(1)
Which devices need its attention


(2)
The type of attention they need

d. Windows XP Professional provides 16 interrupts (0–15) that are assigned to devices. 


(1)
IRQ 1 is assigned to the keyboard.


2.
I/O ports

a.
I/O ports are a section of memory that a hardware device uses to communicate with the operating system.


b.
When Windows XP Professional receives an IRQ, it checks the I/O port address to retrieve additional information about what the device wants it to do.


c.
An I/O port is represented as a hexadecimal address.


3.
Direct memory access (DMA)


a.
DMAs are channels that allow a device, such as a floppy disk drive, to access memory directly, without interrupting the microprocessor.


b.
DMA channels speed up access to memory.


c.
Windows XP Professional has eight DMA channels (0–7).


4.
Memory

a.
Many hardware devices, such as network interface cards (NICs), use onboard memory or reserve system memory.


b.
This reserved memory is not available to other hardware devices or to Windows XP Professional.


C.
Determine which hardware resources are available.
1. In Device Manager, on the View menu, click Resources By Connection.


a.
Device Manager displays the resources that are currently in use.


2.
To view a list of resources for another type of hardware resource, click the type of hardware resource you want to see on the View menu.


D.
Use the Add Hardware Wizard to install the hardware manually.
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5.
Changing Hardware Resource Assignments


A.
Use Device Manager to instruct the operating system on device configuration.

1.
In the Hardware tab of the System Properties dialog box, click Device Manager.

2.
Expand the device list.

3.
Right-click the device, and then click Properties.

4. In the Properties dialog box for the device, click the Resources tab.

5. Follow the procedure for choosing a hardware resource during a manual installation.

B.
Changing the resource assignments for non–Plug and Play devices in Device Manager does not change the resources used by that device.

1.
You cannot use Device Manager for this purpose.


2.
To change the resources used by non–Plug and Play devices, consult the device documentation to determine whether switches or jumpers must be configured on the device.

Chapter 11, Lesson 2

Configuring and Troubleshooting Hardware Devices
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1.
Using Device Manager to Change Resource Settings


A.
You must be logged on as a member of the Administrators group.


B.
Policy settings on the network might prevent members of the Administrators group from changing resource settings.

C.
You can disable your hardware and cause your computer to stop working if you improperly change resource settings.
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D.
Windows XP Professional automatically arbitrates Plug and Play resources.

1.
The resource allocation among Plug and Play devices is not permanent.

2.
If a Plug and Play device requests a resource that is already allocated, Windows XP Professional can again arbitrate the resources to satisfy all devices.


3.
You should not change resource settings for a Plug and Play device manually because Windows XP Professional will then be unable to arbitrate the assigned resources if requested by another Plug and Play device.


4.
Plug and Play devices have a Resources tab in their Properties dialog box in Device Manager.


a.
Select the Use Automatic Settings check box in the Resources tab to free the resource settings you manually assigned and allow Windows XP Professional to arbitrate the resources again.
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2.
Using Device Manager to Configure and Troubleshoot Devices


A.
In Device Manager, in the details pane, double-click the device type, and then double-click the device.

B.
The tabs available in the device Properties dialog box vary, depending on the device selected.


1.
Advanced or Advanced Properties


a.
The properties listed vary, depending on the device.


b.
Modems: can be used to set extra initialization commands, and depending on your modem, you may be able to select country/region, select advanced port settings (such as the COM port), and adjust for connection problems


c.
Network Adapters: can be used to set the link speed and duplex mode, and the receive buffers


2.
General

a.
Displays the device type, manufacturer, and location


b.
Displays the device status


c.
Provides a troubleshooter that steps you through a series of questions to help resolve any problems


3.
Device Properties 


a.
The properties listed vary, depending on the device.


4.
Properties


a.
Determines the way Windows uses the device, for example:


(1)
DVD-ROM: sets the volume control for music, and allows you to configure the device to use digital instead of analog audio playback


(2)
Audio controller: lists properties for each of the multimedia devices it controls


5.
Driver

a.
Displays the driver provider, driver date, driver version, and digital signer


b.
Click Driver Details to get additional information such as the name and location of the driver files.


c.
You can uninstall, update, or roll back the driver.


6.
Port Settings: displays and allows you to configure settings for bits per second, data bits, parity, stop bits, and flow control for a COM port


7.
Resources


a.
Displays the resource type and settings


b.
Displays whether there are any resource conflicts

c. Displays whether you can change the resource settings


C.
To configure a device, click the appropriate tab.


D.
To troubleshoot a device, click Troubleshooter in the General tab.
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3.
Viewing Hidden Devices


A.
By default, Device Manager does not display all devices.


B.
Hidden devices include non–Plug and Play devices and devices that are not currently connected to the computer (phantom devices).


C.
To view phantom devices


1.
Click Start, and then click Run.

2.
In the Open text box, type cmd and then click OK.


3.
At the command prompt, type                                                                    set devmgr_show_nonpresent_devices=1

4.
Press Enter.


5.
At the command prompt, type start devmgmt.msc


D.
To set Device Manager to always show phantom devices, add the following system environment variable: 
set devmgr_show_nonpresent_devices=1
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4.
Installing and Configuring Fax Support


A.
Windows XP Professional provides complete fax support.


1.
You can send and receive faxes with a locally attached fax device.


2.
You can send and receive faxes with a fax device connected on your network.


3.
You can monitor and track faxes.


B.
You must install Fax Services; it is not installed by default.


C.
You must configure Fax Services.

5.
Managing and Troubleshooting Fax Support


A.
Use the Fax Console to manage and troubleshoot faxes.
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B.
The Outbox contains all faxes that are waiting to be sent or that are in the process of being sent.


1.
To delete a fax, right-click the fax in the details pane of the Fax Console, and then press Delete or click Delete on the File menu.

2.
To pause a fax, right-click the fax in the details pane, and then click Pause.

3.
To resume sending a paused fax, right-click the fax in the details pane, and then click Resume.

4.
To attempt to send a failed fax again, right-click the failed fax in the details pane, and then click Restart.

5.
To save a copy of a fax, right-click the fax in the details pane, and then click Save As.

6.
To mail a copy of a fax to someone, right-click the fax in the details pane, and then click Mail To. 


7.
To print a copy of a fax, right-click the fax in the details pane, and then click Print.
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C.
The Incoming box allows you to manage incoming faxes.


1.
To delete a fax, right-click the fax in the details pane, and then press Delete or click Delete on the File menu.

2.
To pause a fax, right-click the fax in the details pane, and then click Pause.

3.
To resume receiving a paused fax, right-click the fax in the details pane, and then click Resume.

4.
To save a copy of a fax, right-click the fax in the details pane, and then click Save As. 

5.
To mail a copy of a fax to someone, right-click the fax in the details pane, and then click Mail To. 

6.
To print a copy of a fax, right-click the fax in the details pane, and then click Print. 
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D.
Fax troubleshooting scenarios


1.
When you click the Print button on the application’s toolbar, the fax does not print to a fax printer.

a.
The Print button on the toolbar of some Microsoft Windows applications does not use the Print dialog box, so the fax prints to the last printer used.

b.
On the File menu of your Windows application, click Print to access the Print dialog box so that you can select your fax printer.

2.
A fax you sent is pending in the Outbox.

a.
Verify that there is a local fax device and that it is configured correctly.

b.
On the Tools menu of the Fax Console, click Fax Printer Status to verify that the remote fax device is not busy.

3.
Someone sent you a fax, and your incoming fax device is not detecting the call.

a.
Verify that the local fax device is configured to receive faxes.

b.
If you have an external modem, turn it off and then back on.

c.
If you have an internal modem, shut down your computer and restart it.

4.
You are using dialing rules with a calling card, but the calling card information is not working.

a.
Calling card information is defined on a per-user basis.

b.
Ensure that Fax Services is running and is using the same user account as the calling card information.

(1)
Right-click My Computer, click Manage, and then click Services And Applications.

(2)
In the Services list, double-click Fax, and then click Log On.

(3)
Set Fax Services to run under the calling card user account.

c.
If you have an internal modem, shut down your computer and restart it.

5.
You cannot send faxes with Microsoft Outlook Express.

a.
Outlook Express is not compliant with a Messaging Application Programming Interface (MAPI) client interface and cannot be used to send faxes.
b. Use Microsoft Outlook 2000.

|16|
6.
Managing and Troubleshooting I/O Devices


A.
Scanners, cameras, and other imaging devices


1.
Most cameras, scanners, and other imaging devices are Plug and Play devices that are automatically installed and configured when you connect them to your computer.

2.
If your imaging device is not automatically installed when you connect it, install it manually.

a.
Click Start, click Control Panel, and then click Printers And Other Hardware.

b.
Click Scanners And Cameras. In the Scanners And Cameras window, double-click Add An Imaging Device to start the Scanners And Cameras Installation Wizard.

c.
Click Next and follow the on-screen instructions.

3.
In Device Manager, select the appropriate device, and then click Properties to add, remove, or configure your imaging device.

4.
If you have problems with your imaging device, click Troubleshoot in the Scanners And Cameras Properties dialog box.

B.
Mouse devices

1.
To configure or troubleshoot your mouse device, click the Mouse icon in the Printers And Other Hardware window of Control Panel.

2.
Use the Buttons tab to

a.
Configure your mouse for a left-handed or right-handed user

b.
Set a single mouse click as select or open

c.
Set the double-click speed

3.
Use the Pointers tab to select or create a custom scheme for your pointer.

4.
Use the Pointer Options tab to

a.
Adjust the speed and acceleration of your pointer

b.
Set the Snap To Default option, which moves the pointer automatically to the default button in a dialog box

5.
Use the Hardware tab to

a.
Access the Troubleshooter

b.
Perform advanced configuration on your mouse. Click the Properties button to

(1)
Uninstall or update your mouse driver

(2)
View or change the resources allocated to your mouse

(3)
Increase or decrease the sensitivity of your mouse by varying the sample rate, which Windows XP Professional uses to determine the position of your mouse

C.
Modems

1.
Click the Phone And Modem Options icon in the Printers And Other Hardware window of Control Panel.

2.
Using the Modems tab

a.
To install a new modem, in the Modems tab, click Add.

b.
To uninstall a modem, in the Modems tab, click Remove.

c.
To configure an installed modem, in the Modems tab, select the modem from the list of installed modems, and then click Properties.

3.
Using the Dialing Rules tab

a.
You can view a list of all locations you have configured on this computer.

b.
To add a new location, click New.

c.
To remove a location, select the location, and then click Delete.

d.
To edit the dialing properties for a location, select the location, and then click Edit.

D.
Game controllers

1.
Click the Game Controllers icon in the Printers And Other Hardware window of Control Panel to configure or troubleshoot your game controller.

2.
If the controller did not install properly when you attached it, in Device Manager, look under Human Interface Devices.

a.
If the controller is not listed and it is a universal serial bus (USB) game controller, make sure that the USB is enabled in BIOS.

b.
When prompted during system startup, enter the BIOS setup and enable USB, or contact the vendor for your computer to get the latest BIOS.

E.
IrDA and wireless devices

1.
Most IrDA devices should be installed automatically.

2.
If you attach an IrDA transceiver to a serial port, you must install it using the Add Hardware Wizard.

3.
To configure an IrDA device, in Control Panel, click Wireless Link.

a.
In the Hardware tab, click the device you want to configure.

b.
Click Properties to view the status of the device, the driver files, and any power management settings.

4.
The Wireless Link icon appears in Control Panel only if you have already installed an infrared device on your computer.


F.
Keyboards

1.
To configure your keyboard, click Keyboard in the Printers And Other Hardware window of Control Panel.

a.
Use the Speed tab to configure the character repeat delay, the character repeat rate, and the cursor blink rate.

b.
Use the Hardware tab to view the device properties for the installed keyboard.

c.
Click Properties in the Hardware tab to update a device driver, roll back to a previous device driver, or uninstall a device driver.

2.
To troubleshoot your keyboard, click Keyboard in the Printers And Other Hardware window of Control Panel, and in the Hardware tab, click Troubleshoot.
Chapter 11, Lesson 3

Viewing and Configuring Hardware Profiles
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1.
Understanding Hardware Profiles


A.
A hardware profile stores configuration settings for a set of devices and services. It specifies


1.
Which devices Windows XP Professional should start when the computer is started

2.
Which settings to use with each device


B.
Hardware profiles are used primarily for portable computers.

1. A portable-computer user can create


a.
One hardware profile for the docked computer

b.
A different hardware profile for the undocked computer


2.
The user selects the appropriate profile at startup.
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2.
Creating or Modifying a Hardware Profile


A.
Windows XP Professional creates an initial profile during installation, which appears in the Available Hardware Profiles List as Profile1 (Current).

B.
To copy a hardware profile

1.
Select one of the hardware profiles in the Available Hardware Profiles list.

2.
Click Copy.


C.
To modify a hardware profile

1.
Select one of the hardware profiles in the Available Hardware Profiles list.


2.
Click Properties.


3.
Modify the properties as needed, and then click OK.


D.
To rename a hardware profile

1.
Select one of the hardware profiles in the Available Hardware Profiles list.


2.
Click Rename.


3.
In the Rename Profile dialog box, in the To text box, type a new name, and then click OK.


E.
To delete a hardware profile

1.
Select one of the hardware profiles in the Available Hardware Profiles list.


2.
Click Delete.


F.
To configure which hardware profile will be activated

1.
The order of the profiles in the Available Hardware Profiles list determines the default order at startup.


a.
The first profile in the list becomes the default profile.

b.
Use the arrows to the right of the Available Hardware Profiles list to change the order of the profiles in the list.

2.
Select one of the following options:


a.
Wait Until I Select A Hardware Profile


b.
Select The First Profile Listed If I Don’t Select A Profile In

 
(1)
You can set the time limit (in seconds) for choosing a hardware profile.


(2)
The default time limit is 30 seconds.

Chapter 11, Lesson 4

Configuring, Monitoring, and Troubleshooting Driver Signing
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1.
Understanding Driver Signing


A.
Windows XP Professional drivers and operating system files have been digitally signed by Microsoft to ensure their quality.


B.
In Device Manager, look in the Driver tab of the Properties dialog box for a device to verify that the digital signer of the installed driver is correct.
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2.
Configuring Driver Signing


A.
Use the following options in the Driver Signing Options dialog box to configure what you want Windows XP Professional to do if it discovers software that has not passed Windows Logo testing.


1.
Ignore: allows any files to be installed regardless of their digital signature or the lack thereof
2. Warn 


a.
Displays a warning message before allowing the installation of an unsigned file


b.
Is the default option


3.
Block: prevents the installation of unsigned files


B.
Select or clear the Make This Action The System Default check box.


1.
Selecting this check box applies the driver signing configuration to all users who log on to the computer.


2.
Only a member of the Administrators group can select this check box.
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3.
Monitoring and Troubleshooting Driver Signing


A.
System File Checker (SFC) 


1.
A command line tool

2.
Allows you to check the digital signature of files


B.
SFC optional parameters


1.
/scannow: causes the SFC tool to scan all protected system files immediately

2.
/scanonce: causes the SFC tool to scan all protected system files once at the next system restart


3.
/scanboot: causes the SFC tool to scan all protected system files every time the system restarts

4.
/revert: causes the SFC settings to be returned to the default settings


5.
/purgecache: purges the file cache


6.
/cachesize=x: sets the file cache size
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4.
Using the Windows File Signature Verification Tool


A.
Using Sigverif


1.
Click Start, and then click Run.


2.
Type sigverif in the Open text box, and then click OK.


B.
Sigverif verifies that the files on your system are digitally signed.


C
Sigverif records the following information in the SIGVERIF.TXT log file:


1.
File name

2.
Location


3.
Modification date


4.
File type


5.
Version number


D.
To view and configure the log file or to set file verification options, click Advanced in the File Signature Verification window.

Chapter 11, Lesson 5

Configuring Computers with Multiple Processors
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1.
Scaling


A.
Adding processors to your computer to improve performance is called scaling.


B.
Scaling is more of an issue for servers than for computers running Windows XP Professional because

1.
Multiple processors are usually used for processor-intensive applications

2.
Database servers or Web servers typically use multiple processors


C.
Multiple processors can also benefit computers running applications that perform heavy computations such as


1.
Scientific or financial applications


2.
Complex graphic rendering applications such as computer-aided design (CAD) programs
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2.
Updating Drivers


A.
You would update a driver when 


1.
A new version of the driver is released


2.
You want the driver to support multiple processors

B.
You cannot make a computer with only one processor into a multiple-processor computer.


1.
A computer with only one processor might no longer function if you upgrade the driver to one that supports multiple drivers.
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Chapter Summary

A.
For most Plug and Play hardware, you connect the device to the computer and then Windows XP Professional automatically configures the new settings.


B.
For the occasional Plug and Play or non–plug and Play hardware device that Windows XP Professional does not identify, install, and configure, you must initiate hardware installation with the Add Hardware Wizard.


C.
The Device Manager snap-in provides a list of all hardware resources and their availability, provides a graphical view of the hardware installed on your computer, and helps you manage and troubleshoot the hardware.

|26|
D.
Use the appropriate hardware icon in Printers And Other Hardware on Control Panel to configure and troubleshoot a hardware device.


E.
A hardware profile stores configuration settings for a set of devices and services.


F.
The primary use of hardware profiles is for a portable computer that can use different hardware configurations depending on whether it is docked or undocked.

|27|
G.
Windows XP Professional provides two tools to verify the digital signatures of system files: SFC and File Signature Verification.


H.
Adding processors to your system to improve system performance is called scaling.


I.
If your computer only has a single processor, upgrading the driver is not going to make it a multiple-processor computer, and the upgrade could prevent your computer from running.


J.
You use Device Manager to update drivers whenever a newer version of a driver is released or if you want to upgrade a driver.
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